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1. Changelog 
This section will contain information about revision changes in the documentation. 

Date added Element Event Change Comment 

2019-02-06 Added/updated Web Service methods: 
 
Get Budget Details 
Get General Ledger Updates 
Get Link Values 
Get Payroll Summary 
Get Supplier Balances 
Get Workflow Journal Headers 
Get Workflow Journal Headers Simple 
 

Routine 
update 

New Web Services 
added to the overview 

 

2019-02-06 Added/updated import definitions: 
GL02H 
GL11b 
OVI 
LG08TMP 
SO01b_2 
SO03 
SO04 
HR09 
PR01-3 
RM02 
  

Routine 
update 

New import formats 
added to the 
overview.  

 

21.05.2019 N/A Change 
in policy 

Added section 1.6: 
Information about 
data traffic in Xledger 

Added 
information 
regarding newly 
implemented 
changes w/ data 
traffic invoicing 

 

2. General introduction 
This section aims to provide an overview of the guiding principles for integrations in Xledger. 

2.1 Importing to Xledger 
Importing to Xledger is for the most part done by CSV-files. These can either be automatically 
imported through the API or uploaded by the end user manually within the system GUI. 
 
Xledger has a wide variety of different import formats corresponding with the various modules 
featured in Xledger. An overview of these can be found in this document, starting here. 
 
Documentation of the import formats in Xledger are provided to customers and prospects on 
demand. The documentation consists of a record description in a .docx format as well as a sample file 
in .csv-format. 
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Xledger also support XML imports to certain modules, and will implement more XML-based import 
formats in the future. 
 
In May 2018, Xledger added a GraphQL API that allows for direct data entry into the database. See 
section 1.5. 
 

2.1.1 Automated import 
For automated import of files to Xledger, there are two main alternatives that can be used: 
 

1. ReceiveFile Web Service method:  

This is a Web Service call (SOAP) where the method call is used to directly upload a file to the 

system. The method call needs to contain information about i.e. which entity it should be 

uploaded to, what import definition the file is to be read as etc.  

 

The advantage with using this approach is that it can facilitate a direct export from the 

source system to Xledger without having to use/maintain an external service (such as Xledger 

Folder Service). The potential disadvantage is that it needs to be coded by someone with 

technical proficiency. 

 

2. Xledger Folder Service:  

This is an internally developed application/service that can be installed on a client or server. 

It will monitor a given directory on the client or server and – if configured correctly – 

automatically upload any file placed in aforementioned directory to its target entity in 

Xledger. Folder Service is common in regards to for instance uploading End-of-day reports 

from cashier systems. One single Folder Service installation can serve a vast amount of 

entities in Xledger simultaneously. 

 

The advantage of using this approach is that it is relatively easy to set up – the installation 

requires no programming skills. The potential disadvantage is that the Folder Service 

becomes an additional part of the process chain. 

2.2 The role of automated processes 
After a file has been uploaded to Xledger via the API, it will be ready for processing. Once the central 
server job for file processing is executed, the file’s content can be found in the module corresponding 
with its content type (i.e. customer registry). 
 
The central server job is run on scheduled intervals numerous time during the course of a day.  
Users with a sufficiently advanced access may also order this server job on demand. Please note that 
the DEMO and TEST environments does not feature the same automated processing. As such, the 
processes need to be executed manually. See procedure description below. 
 

2.2.1 Procedure 
1. A file has been imported and is in the state “Ready to process”. In the production 

environment, it will be processed further with the next execution of a central process. In 

DEMO, the server job needs to be executed manually. 
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2. The server job is called “Processing”. Depending on the type of format and its content, the 

data will or will not need additional processing before reaching its destination module in 

Xledger. For instance, a format which will make accounting vouchers (GL02b, AR10, XI10 etc.) 

will reach the accounting module via “GL Import”.  Data coming from customer or supplier 

import format (AR02, AP02) will on the other hand be loaded directly into the registries. 

 
3. For this example, a GL02b file containing general ledger transactions was imported. The rows 

are thus located in a staging area called GL Import prior to being processed into the general 

ledger. 
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4. The server job that ensures transfer from GL Import into the accounting module is called 

Voucher Import. It performs certain validations such as whether the accounts used are valid 

and whether mandatory information (varies based on account type) is provided. If not, the 

rows affected by this will show in the GL Import screen with an icon indicating an error. If all 

the necessary data is provided, the voucher will be accessible from the accounting module. 

 
5. When the Voucher Import job is finalized, the voucher is shown in the general ledger. If the 

amounts etc. match from an accounting perspective, the voucher is automatically posted. If 

there is discrepancies between debits and credits and the voucher does not add up, it will 

require manual follow-up in the Journal Entry list. 

 

2.3 Exporting from Xledger 
There are two main ways to export data from a Xledger Entity: 
 

1. In-GUI exports:  

The majority of Xledgers menus and rows may be exported on-demand from within the 

graphical user interface. The columns and amount of rows can be customized prior to export. 

The data is exported in a Excel format. In addition, there are also certain server jobs that can 

be executed in order to export large amounts of data. This is the best option for one-time 

exports. 

 

2. Web Service exports:  

Xledger supports a large variety of export methods (SOAP) that allows for extraction of data 

i.e. for use in external systems. A list of all available export methods can be found here. The 
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data selection can be narrowed by numerous filters that can easily be added to the method 

call parameters. The data return is in XML format. Web Service exports is the best option for 

recurring exports. 

 

3. GraphQL: 

See section 1.5. 

2.4 Existing integrations Xledger <-> External systems 
Xledger is already integrated with numerous systems that either extract or import data into the 
system. This includes i.e. cashier systems, invoicing systems, CRM systems, web shops, annual report 
systems and more. We are continuously updating our overview of existing integrations – feel free to 
contact support@xledger.net for inquiries about any specific system. 
 
We also collaborate closely with integration partner ConnectMyApps, who are highly experienced 
with the Xledger API. Should you require a new integration currently not supported, ConnectMyApps 
can help establishing this integration.  

2.5 GraphQL 
From May 2018, Xledger added a GraphQL API, which opens up for a lot of new integration 
capabilities.  GraphQL is a data query language developed internally by Facebook in 2012 before 
being publicly released in 2015. It provides an alternative to REST and ad-hoc web service 
architectures. In addition to supporting more tailored queries, it also allows for direct data entry into 
Xledger without the need for a file-based integration architecture. 
 
For more in-depth information about the GraphQL API, please see the standalone documentation. 
 

2.6 Information about data traffic in Xledger 

2.6.1 Background 
As of Q1 2019, usage of Web Services and the GraphQL API will be invoiceable. The primary reason 
for charging for data traffic is to incentivize sensible usage, as we have in numerous occasions 
experienced extremely high loads on the system. In the utmost of cases, this is highly unnecessary; 
we find it rather unlikely that anyone have a need for a complete export of their general ledger 
transactions for all years returned every 5 seconds (which has been the case quite more than once). 
 
By implementing this, we are aligning with major actors such as Microsoft and Amazon. Both have 
quite extensive price lists for data traffic. 

2.6.2 Focus on sensible usage of data traffic 
The key to achieving sensible data traffic usage is to only ask for either new or changed data. Just 
about all the Web Service and GraphQL queries allows for filtering on modified date. Applying this 
will allow for only fetching data since the last query, which naturally will return significantly less data 
than a complete export of the dataset. For General Ledger transactions, we have a dedicated query 
called GetGeneralLedgerUpdates that we recommend using. 
 
The general recommendation: Aspire to fetch only the data you need and little else. 

mailto:support@xledger.net
http://www.connectmyapps.com/applications/xledger
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We acknowledge that for many customers, data traffic is not something that’s on the forefront of 
their minds. As such, a certain level of lenience in the transition period can be expected from our 
part. It is however important to stress that in the end, the customer is responsible for the data traffic 
caused by the integrations and the 3rd parties that operate them. 
 
The image below illustrates the volume difference between sub-optimal and sensible querying. 
 

 
 

3. Web service Export methods 
 

3.1 Get Approval Tasks Summary 
From Menu path: Task list (Oppgaveliste) 
Returns exclusively voucher approval related-tasks from the Task list in the left menu of the Xledger 
interface. In the method call, User ID (username in Xledger) and Menu group must be amongst the 
parameters. The value in Menu Group is that of access roles in Xledger. Examples of Role code values 
are the following here:  

- 1302: Finansleder / Finance Manager 

- 1303: Ansatt / Employee 

- 1304: Regnskapsfører / Accountant 

The user account (User ID) must have access to the chosen role on the entity if this method is to be 
used. 
 

3.2 Get Bank Disposals 
From Menu path: Home (Hjem) 
Returns data from the Cash Flow (Likviditet) block on the Home menu. 
 

3.3 Get Budget Details 
From Menu path: Financials > Budget > Budget Registration 
Returns budget rows as XML elements. 
 

3.4 Get Customer Balances 
From Menu path: Customer > Aging – Open items (Kunde > Fakturaoppfølging) 
Returns data regarding invoices whose Due date has passed. Data return is grouped per customer. 
 



11/24 

3.5 Get Customer Transactions 
From Menu path: Customer > Customer Transactions > Transactions by Customer (Kunde > 
Kundetransaksjoner) 
Returns customer transactions. By setting DataOption / eOption to value = 1, it will exclusively return 
open items.  
 

3.6 Get Customers 
From Menu path: Customer > Customers (Kunde > Kunderegister) 
Returns data from the entity’s customer registry. 
 

3.7 Get Customers 2 
From Menu path: Customer > Customers (Kunde > Kunderegister) 
Same as Get Customers, but with a more extensive data return. 
 

3.8 Get Debt Collection Item Details 
Returns detailed data regarding invoices that has been transferred to collection. This method is 
primarily meant for collection agencies. 
 

3.9 Get Debt Collection Items 
Returns detailed data regarding invoices that has been transferred to collection. This method is 
primarily meant for collection agencies. 
 

3.10 Get Debt Payment Items 
Returns payment details related to the above export methods. This method is primarily meant for 
collection agencies. 
 

3.11 Get Employee Balances 
Not operational at present time. 
 

3.12 Get Employee Details 
From Menu path: Payroll/Expenses > Employees and Payroll/Expenses > Employees > Employee 
Position (Lønn/Reise > Ansatte og Lønn/Reise > Ansatte > Stillinger Ansatte) 
Returns basic information about employees as well as their linked position(s). Could be viewed as a 
combination of Get Employees and Get Employee Positions. 
 

3.13 Get Employee Positions 
From Menu path: Payroll/Expenses > Employees > Employee Position (Lønn/Reise > Ansatte > 
Stillinger Ansatte) 
Returns data regarding employee position(s). 
 

3.14 Get Employees 
From Menu path: Payroll/Expenses > Employees (Lønn/Reise > Ansatte) 
Returns data from the employee registry. 
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3.15 Get Entities 
From Menu path: Admininistration > Entity (Administrasjon > Enhet) 
Returns data regarding entities in the hierarchy. The method is primarily meant to be used at a 
Domain/Holding Entity to give an overview of the underlying entities. The method can be used to 
return Entity Code (Eier ID) on underlying entities – the code will be returned in the field 
<OwnerCode>. 
 

3.16 Get Exchange Rates 
From Menu path: Administration > Setup > Currency > Rates (Administrasjon > Oppsett > Valuta > 
Vekslingskurser) 
Returns data regarding currency rates. In Xledger, the rates will be imported daily at 17.00 CET. It is 
highly recommended that you use the DateFrom filter to receive the latest rate. Please note that 
there is no daily update in the XLEDGERTEST application. 
 

3.17 Get File Imports 
From Menu path: Import > File Import (Forsystem > Filimport) 
Returns status of import files that is scheduled to be imported or already have been processed. It can 
be used as a validation of whether ones own export files has been processed. Status is returned in 
<Joblevel> and can be the following: 

a. Draft/Kladd – The file requires approval from user. After approval its status will be changed 

to “Ready to process”. 

b. Ready to process/Klar til kjøring – The file will be processed the next time the server job 

«Processing» runs (either manually or as scheduled in the system). This is the default value 

when importing files through Web Services.  

c. Processing /Under kjøring – The file is being processed at the very moment. 

d. Processed/Kjørt – The file has been processed and has found its way into the system in 

accordance with the import format definition. 

e. Failed/Feilet – The file import has failed due to i.e. formatting error (no. of columns, date 

format etc.). This is a clear indication that there is an error in the file that should be 

examined as it prohibits data import. 

3.18 Get Financial Ratio 
From Menu path: Home (Hjem) 
Returns data from the block “Key Performance Indicators” (Nøkkeltall) on the Home menu. KPI’s can 
be defined per entity in Xledger. 
 

3.19 Get General Ledger 
From Menu path: Financials > Transactions (Økonomi > Transaksjoner) 
Returns all General Ledger transactions. Due to a (usually) quite large volume, users are 
recommended to actively use filtering when working with this export method.  
 

3.20 Get General Ledger Balance 
Returns General Ledger transactions on balance accounts exclusively. 
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3.21 Get General Ledger Profit and Loss 
Returns General Ledger transactions on P&L accounts exclusively.  
 

3.22 Get General Ledger Updates 
Returns only General Ledger transactions updated recently. 
 

3.23 Get Journal Headers 
From Menu path: Accounting > Journal Follow-up > Journal Header (Regnskap > Bilagsoppfølging > 
Bilagshode) 
Returns data regarding vouchers on a header level. The parameter “Include File Content” allows for 
extracting the voucher image in a base64-encoded format. 
 

3.24 Get Link Values 
From Menu path: Administration > Objects > Link Values 
Returns Link Values active on the current entity. Can be information such as Employee Manager 
relationships, Cost Center Managers, Project Managers a.s.o. 
 

3.25 Get Link Values By Project Access 
Returns employees’ project access. Corresponding Menu path in Xledger is Administration > Objects 
> Link Values with Link “Employees on Project”. 
 

3.26 Get New Users 
Not operational per 2019-02. 
 

3.27 Get Object Values 
See dedicated section on Objects. 
 

3.28 Get Object Values Customers 
Returns GUID value on customers. 
 

3.29 Get Object Values Suppliers 
Returns GUID value on suppliers. 
 

3.30 Get Objects 
See dedicated section on Objects. 
 

3.31 Get Open Items AP Aging 
From Menu path: Home (Hjem) 
Returns data from Accounts Payable in the block Subledger Open Items at the Home page. 
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3.32 Get Open Items AR 
From Menu path: Customer > Customer Transactions > Open Items (Kunde > Kundetransaksjoner > 
Åpne poster) 
Returns data on open customer transactions. In that regard it is not very dissimilar to Get Customer 
Transactions. Alternative DataOption / eOption setting (value = 2, value = 3) will be able to provide 
historical insights. 

3.33 Get Open Items AR Aging 
From Menu path: Home (Hjem) 
Returns data from Account Receivable in the block Subledger Open Items at the Home page. 
 

3.34 Get Open Items DG 
From Menu path: Customer > Customer Transactions > Donations (Kunde > Kundetransaksjoner > 
Givertjeneste) 
Returns data on open Donation transactions.  
 

3.35 Get Order Details 
From Menu path: Billing > Orders > Overview Order (Fakturering > Ordre > Oversikt Ordre) 
Returns data from the Order registry. The XML returns contains both order header as well as detailed 
row overview. 
 

3.36 Get Payment Approvers 
Not operational per 2019-02. 
 

3.37 Get Payroll Rates Simple 
From Menu path: Payroll/Expenses > Rate and Tables > Rate Setup (Lønn/Reise > Satser og tabeller 
> Satsoppsett) 
Returns data from the Payroll Rate registry.  
 

3.38 Get Payroll Summary 
From Menu path: Payroll/Expenses > Inquiry > Payroll Statistics 
Returns summarized information about employee payroll details. 
 

3.39 Get Price Lists 
From Menu path: Billing > Product > Price Setup > Pricelist (Fakturering > Produkt > Pris oppsett > 
Prisliste) 
Returns data from the pricelist registry. XML return contains both locally created ones as well as 
pricelists inherited from higher up in the hierarchy.  
 

3.40 Get Products 
From Menu path: Billing > Product > Product (Fakturering > Produkt > Produkter) 
Returns the available billable products in the product registry. 
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3.41 Get Project Summary 
Related Menu path: Project > Project summary (Prosjekt > Prosjektforside) 
This is a highly sophisticated method that allows for exporting detailed data related to ongoing and 
historical projects. There is a wide selection of necessary parameters as well as filtering options. The 
reader is advised to consult the documentation “Xledger Web Services – Reviosion YYYY-MM-DD” for 
an overview of these. 
 

3.42 Get Projects 
From Menu path: Project > Projects (Prosjekt > Prosjekter) 
Returns the products from the product registry. 
 

3.43 Get Sales Order Details 
From Menu path: Billing > Billing > Invoice overview (Detail rows per invoice) (Fakturering > 
Fakturering > Oversikt salgsordre (Detaljer per salgsordre)) 
Returns data regarding invoices, with an emphasis on the invoice rows. 
 

3.44 Get Sales Orders 
From Menu path: Billing > Billing > Invoice overview (Fakturering > Fakturering > Oversikt 
salgsordre) 
Returns data regarding invoices (open and historical) on the entity. 
 

3.45 Get Sales Orders Simple 
From Menu path: Billing > Billing > Invoice overview (Fakturering > Fakturering > Oversikt 
salgsordre) 
Returns simplified data regarding invoices (open and historical) on the entity. 
 

3.46 Get SO Details 
From Menu path: Billing > Billing > Billing Input Details > SO Details (Fakturering > Fakturering > 
Fakturagrunnlag > Fakturagrunnlag) 
Returns SO detail rows. Allows for extracting invoice transaction prior to invoice generation. 
 

3.47 Get Simple Account Balance 
Returns balance per account. 
 

3.48 Get Supplier Transactions 
From Menu path: Supplier > Transactions by supplier (Leverandør > Leverandørtransaksjoner) 
Returns data on supplier transactions. By setting DataOption / eOption to value = 1, it will exclusively 
return open items. Historical transactions can be viewed by choosing value = 2 or value = 3. 
 

3.49 Get Supplier Balances 
From Menu path: Supplier > Supplier Transactions > Aging - Open Items 
Returns an aggregated overview over open items per supplier. 
 



16/24 

3.50 Get Suppliers 
From Menu path: Supplier > Supplier registry (Leverandør > Leverandørregister) 
Returns data from the supplier registry on the entity. Please note that employees will also appear 
here, as they are created as suppliers in Xledger. These can easily be identified as they are returned 
with value <SupplierGroup>Ansatte</SupplierGroup>. 
 

3.51 Get Task Summary 
From Menu path: Task list (Oppgaveliste) 
Returns data from the Task list in the left menu of the Xledger interface. In the method call, User ID 
(username in Xledger) and Menu group must be amongst the parameters. The value in Menu Group 
is that of access roles in Xledger. Examples of Role code values are the following here:  

- 1302: Finansleder / Finance Manager 

- 1303: Ansatt / Employee 

- 1304: Regnskapsfører / Accountant 

The user account (User ID) must have access to the chosen role on the entity if this method is to be 
used. 
 

3.52 Get Tax Assessments 
From Menu path: Financials > Period/Term Ending > Year End > Tax Assessment (Økonomi > 
Periode/terminslutt > Årsoppgjør > Grunnlag skatt) 
Returns data from the menu path listed above. Fiscal Year must be defined as a parameter in the 
method call. 
 

3.53 Get Timesheet Entries 
From Menu path: Home > Timesheets > My Timesheet Entry per Day  (Hjem > Timelister > Min 
timeføring daglig) 
Returns data from the menu path listed above. Both From- and To-dates needs to be defined  as 
parameters in the method call. 
 

3.54 Get Timesheet Summary 
Related menu path: Project > Timesheet Enquiry (Prosjekt > Timespørring) 
Returns data regarding employees’ timesheets over a given period of time. The method includes 
several filtering methods as well as parameter requirements – these are listed in the documentation 
“Xledger Web Services – Reviosion YYYY-MM-DD”.  
 

3.55 Get Users 
From Menu path: Administration > System Access > Local Users (Administrasjon > Tilgangskontroll 
> Lokale brukere) 
Returns data regarding the user accounts created locally on the entity. DataOption / eOption 2 and 3 
can be used to extract an historical overview of users that are currently inactive. 
 

3.56 Get Work Orders 
From Menu path: Project > Work Order > Work Order (Prosjekt > Arbeidsordre > Arbeidsordre) 
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Returns data regarding work orders created on the entity. Please note that as of November 2015, the 
Work Order functionality is work in progress. The XML-return will be identical to that of the import 
format for Work Orders, LG07. 
 

3.57 Get Workflow Journal Headers 
From Menu path: Accounting > Journal Entry > Journal Entry List 
Returns information about vouchers/journals currently in workflow. Will return information on both 
Journal Header as well as associated details. 
 

3.58 Get Workflow Journal Headers Simple 
From Menu path: Accounting > Journal Entry > Journal Entry List 
Returns information about vouchers/journals currently in workflow. Will only information on a 
header level.  
 

3.59 Get XCube Data 
From Menu path: Financials > General Ledger > XCUBE Financials (XCUBE Økonomi) 
Returns XCUBE data based on existing XRW Report templates. The XRW report code is required as a 
parameter Template. Should primarily be used in cooperation with advanced Xledger users. 
 

4. Import formats - Accounting & Finance 
 

4.1 AM01 – Assets 
This format is used for importing assets. 
 

4.2 AM02 – Import of asset depreciation 
This format is used for importing asset depreciations. 
 

4.3 AR10 – Invoice journal with Subledger (Mamut-Gbat10) 
This format is used for importing invoice journals. It is identical to the GBAT10 format used by 
Mamut. AR10 may create new subledgers; as a minimum, they will need to contain Code (Column J – 
CustomerCode) and Description (Column L – CustomerName). Subledgers may only be created when 
placed on rows that contain an account that has Ledger Type Accounts Receivable or Accounts 
Payable (1500, 2400 etc). The column VoucherNo will define which rows that will be merged into the 
same voucher. 
 

4.4 GL02 – Accounting journal with Subledger 
This format is used for importing General ledger transactions. GL02 is amongst the most used 
importformats in Xledger. It has the possibility to create subledgers – the same requirements listed in 
AR10 applies also here. GL02 also supports updating subledger information (namely address, email 
etc.); this is done by setting value 1 in column Z (UpdateSubledger). Can be imported with headers by 
choosing import definition GL02H. 
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4.5 GL02b – Accounting journal with Subledger expanded 
This format features the same functionality as GL02, as well as some added features: 

- Option to assign «Entity ID» per row. This facilitates that one import file may import 
vouchers for several (sub-)entities. 

- Option to use periodization for vouchers. 
- Option to define whether a voucher should enter Work flow or not 
- Option to define reporting currency 
- Improved support for importing supplier invoices to the “Unpaid Bills” Menu path; GL02b 

supports import of Pay Code, Pay Doc Code, Pay Doc Text 
- Option to define «Our ref.» as an accounting dimension to workflow 

 

4.6 GL02XML – Accounting Journal With Subledger (XL 

Standard) 
This format is an XML-based variant of GL02b. It supports embedded images in base64-encoding. 
Note that XML formats does not provide the same level of detail in terms of error reporting upon 
processing. 

4.7 GL02H – Accounting journal with Subledger /w header 
Identical to GL02 in column setup. The only difference is that is allows for importing with a header 
row. 
 
 

4.8 GL11 – Budget 
This format is used for importing budget rows. There has to be a reference to an existing budget 
(These can be found in Financials > Budget > Budget setup). 

4.9 GL11b – Budget GL 1-5 
An extended version of GL11 that also supports Posting3, Posting4, and Posting5. 
 

4.10 GL20 – XGL Values 
This format is used for importing XGL values. 
 

4.11 GL21 – Object Values 
This format is used for importing object values. As such, it can be used to define anything from Cost 
Centers to Product Groups. See Administration > Objects > Values for an overview of what objects 
that are supported by GL21. 
 

4.12 GL22 – Chart of Accounts 
This format is used for importing Chart of Accounts.  
 

4.13 GL23 – Object Link Values 
This format is used for importing object link values. As such, it can be used to define anything from 
employee manager links to project access. See Administration > Objects > Link Values for an 
overview of what object links that are supported by GL23. 
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4.14 GL27 – XGL Import (XL UPD) 
This format is used for importing and updating XGL values. Use value 1 or “X” in End of Line to enable 
“Allow posting”. Value “0” unchecks “Allow posting”. 
 

4.15 OVI – Object Values Convert 
This format is used for importing conversion rules to the menu Import > Import > Conversion > 
Object Mapping.  
 

5. Import formats – Bank 
 

5.1 BR01 – Bank statement transactions 
This format is used for importing bank statement transactions. 

6. Import formats - Billing 
 

6.1 LG01 – Products (expired) 
This format was used for importing products to the product registry. We recommend that LG03 is 
used for importing products.  

6.2 LG02 – Pricelist 
This format is used for importing rows to the Menu path Billing > Product > Price setup > Pricelist. 
Note that it needs to have a reference to an existing pricelist. 
 

6.3 LG03(TMP) – Products 
This format is used for importing products to the product registry. It also supports updating existing 
products. Note that Purchasing-related fields need a predefined setup in the logistics/purchasing 
module. 
 

6.4 LG04 – Product prices 
This format is a simplified version of LG03. It only imports the product itself (Code + Description) as 
well as Cost- and Sales price. It supports update of existing entries. 
 
 

6.5 LG05 – Product Trade items sample file 
TBA. 
 

6.6 LG06TMP – Order Import (XL UPD) 
This is an XML-based import format. It supports creating new orders as well as updating existing 
orders, both on header and detail levels. Note that XML formats does not provide the same level of 
detail in terms of error reporting upon processing. 
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6.7 LG07TMP –  Work Order Import (XL UPD) 
This is an XML-based import format. It supports importing new work orders as well as updating 
existing work orders. Note that XML formats does not provide the same level of detail in terms of 
error reporting upon processing. 
 

6.8 LG08TMP – Product Item – Goods Receipts 
This import imports data to the menu Purchasing > Goods Receipt > Goods Receipt. 
 

6.9 LG10TMP – Stocktaking Details 
This import creates details (new rows) in an open Stocktaking. Before starting the import make sure 
you have an open Stocktaking. The Stocktaking number need to be filled in in the first column. Then 
run the Stocktaking processing to complete when the import has been executed. 
 

6.10 SO01 – Invoice base transactions with Subledger 
This format is used for import Invoice base transactions. Rows imported with SO01 will initially be 
found in the Menu path Billing > Billing > Billing Input Details > SO Details. From here, they will 
transferred to Billing > Billing > Invoice Overview whenever the job Invoice Processing is executed 
(manually or by scheduled run). SO01 supports updating subledger address as well as E-mail address. 
Note that shipping method and invoice layout may not be defined through SO01 – this will be 
defined through setup either on customer or entity. 
 

6.11 SO01b – Invoice base transactions with Subledger(XL 

Extended) 
This format is an extended version of SO01. s an extension of the SO01 format. Extensions include 
(among other things): 

- Importing invoice details on a group or domain level for underlying entities 
- Importing periodization invoices 
- Defining Invoice Layout and/or Invoice Delivery Method from import file 
- Defining Invoice Header and Footer either through free text fields or references to 

predefined Invoice Texts 
 

6.12 SO01b_2 – Invoice base transactions with Subledger(XL 

Extended) 
This format has an identical column setup as SO01b. The difference is that it supports different 
values in the UpdateFlag column that dictates different update settings. The options are as follows:  
 
Bit Value Updating 
1 1 Address, Ext.ref, Phone, Email 
2 2 Address 
3 4 Ext.ref, Phone, Email 
4 8 Subledger Name (NOTE: When code is blank then it will demand that the Entity Setup Field 

‘Import Unique Person as Subledger’ is inactive in order to update an existing subledger name) 
5 16 Company/Person Name (NOTE: When code is blank then it will demand that the Entity 

Setup Field ‘Import Unique Person as Subledger’ is inactive in order to update an existing subledger name) 
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For example: If you want to update both subledger name, Ext. Ref, phone and email but not the 
address you would use the bit 3 and 4. This will then mean VALUE = 4+8 = 12 
 
To have all fields and names updated you would use 2+4+8+16 = 30 
 

6.13 SO01P - Invoice base transactions with Subledger and 

Pricelist 
This format has a similar structure to SO01. The only difference is that it will use the prices defined in 
Xledger instead of what is defined per row in the file (which is the case in SO01). 
 

6.14 SO02 - Subscribers for Subscription 
This format imports subscribers for existing subscriptions. 
 

6.15 SO03 – Subscription Setup Import 
This format import Subscription data on a header level. It will primarily import new subscription 
setups to Billing > Billing > Recurring Billing > Recurring Billing. The exception is when value Order 
Type is set to ‘3’ (Donation). In this scenario it will import to XRM > Donation/Funding > Donation 
Setup > Recurring Donations. Note that as of February 2019, this import definition does not feature 
UPDATE functionality. 
 

6.16 SO04 – Subscription Details  
SO04 is meant to be used in combination with SO03. The latter creates new subscription setups, 
while SO04 adds detail rows for an existing subscription. Use Subscription No for identification. 
 

7. Import formats - Payroll 
 

7.1 HR01 – Employee Register 
This format is used for importing employees to the employee registry. Note that changes in the 
Payroll module from 2015-R3 has changed the procedure of creating new employees (Employees are 
now also Contacts). If HR01 is to be used, there will be a need to add Contact manually post-import. 
Note that it also needs employee supplier subledgers to be created in advance. Note: We strongly 
recommend using either HR09 or HR01-2 for importing new employees as it is aligned with the 
contact and supplier registries. 
 

7.2 HR01-2 – Contacts and Employees 
This format is used for importing Employees. It will simultaneously create entries in the Contact and 
Supplier registry. 
 

7.3 HR06 – Employee Positions 
This format is used for import Employee Positions. An employee may have several such. 
 



22/24 

7.4 HR08 – Absence Import 
This format is used for importing employee absence. Employee data as well as absence codes etc. 
must exist prior to import. 
 

7.5 HR09 – Employee registers with update 
This format supports both the creation and update of employees and their corresponding tables 
(Contact, Supplier). 
 

7.6 PR01 – Payroll rates 
This format is used for importing rates to payroll rate elements. If one is to import to an individual 
employee, select Employee / Ansatt in column B (Object) and reference to an employee in column C 
(Object Value). One may import on a position level in a similar fashion. We recommend using PR01-2 
for importing payroll rates as it has more fields available. 
 

7.7 PR01-2 – Payroll rates with employee and position 
This format is reminiscent of PR01. It differs in that it has predefined columns for employee and 
position. Additional parameters may thus be defined in the columns Object / ObjectValue. 
 

7.8 PR01-3 – Payroll rates update with employee and 

position 
This format is identical with PR01-2 in terms of column setup. The difference is that this format also 
supports UPDATE. When a rate element is updated with new values, such as a new rate, the old row 
containing rate element automatically gets a “Date To”  value. 
 

7.9 PR02 – Payroll entry 
This format is used for importing rows to the Menu path Payroll/Expenses > Payroll Setup Overview. 
 

7.10 PR03 – Tax Setup 
This format is used for importing rows to the Menu path Payroll/Employees > Employees > Employee 
Tax Setup. This will in general not be necessary (in Norway) as Xledger may directly access tax 
information from Altinn. 
 

7.11 PR05 – Payroll entry with position 
This format is reminiscent of PR02. It differs in that it also allows for defining employee position. 
 

8. Import formats - Project 
 

8.1 PM01 – Projects 
This format is used for importing projects and potentially project hierarchies (Column C – 
MainProject and Column D – ProjectGroup). The latter requires that the (main) projects are created 
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in advance. Note that PM01 does not support updating existing entries, nor does it check in advance 
whether a project with a given Code/Description already exists in the registry. 
 

8.2 PM10 – Time transactions 
This format is used for importing hour rows for employees. All employees, projects, tasks, and 
project tasks must be created in advance before the format can be used in an appropriate manner. 
 

9. Import formats - Subledger 
 

9.1 AR02 – Customer update 
This format is used both for creation and update of customers in the customer registry. The 
reference should be CustomerCode (Column B). Note that certain columns requires the internal 
system code as a syntax (Invoice delivery method, Invoice Layout, Order Type). Also note that if 
fields are blank in the import file, the same fields will be blanked in the registry in an update. 
Always make sure that the file contains all the information that the customers should have in the 
registry. 
 
Tip: AR02 can be used in combination with Accounts Receivable > Server jobs > Export Customer. In 
the field Export set variant, select AR02. You will then get an export from the system which can be 
modified and imported anew with desired updates. 
 

9.2 AP02 – Supplier update 
Similarly to AR02, AP02 will both create and update new and existing suppliers in the registry. If 
fields are blank in the import file, the same fields will be blanked in the registry in an update. Always 
make sure that the file contains all the information that the suppliers should have in the registry. 
 

9.3 RM02 – XRM Contact with subledger import 
This format is used for importing XRM contacts. It features functionality that allows it to create a new 
subledger entry based on the import simultaneous with the creation of the contact. 
 
 

9.4 SL01 – Opening balance Subledger 
This format is used for importing opening balance on subledgers. Transactions will be imported with 
voucher type OS. Should these be imported with erroneous data, they need to be re-imported with 
inverted amount values in order to match. We thus recommend a high degree of thoroughness 
when working with SL01. 
 

9.5 SL02 – Subledger (Basic) 
This format is used for importing customers and suppliers (LedgerType AR/AP). It has a limited 
amount of fields available. It is recommended for cases where the subledger detail requirement is 
low. 
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9.6 SL03 – Subledger (expanded) 
This format is reminiscent of SL02, but it features additional fields. It should cover the needs of most 
cases. 
 

9.7 SL04 – Subledger (full) 
This format is reminiscent of SL02 and SL03, but with support for all available subledger fields. Will 
primarily only be necessary for cases where there is a very high subledger detail requirement. Note 
that due to the high amount of columns, SL04 does not support verification. 
 

10. Using Object (values) 
Information not available in other methods can in many instances be returned as Object Values. 
An overview of all the existing objects can be returned when executing an unfiltered GetObjects call. 
Objects are returned with the following syntax: 
 
  <Object ID="e7ba11ff-2826-4e89-8192-ba4e94f05e2a"> 
    <Code /> 
    <Description>Contact</Description> 
    <Text>Contact</Text> 
    <SystemObjectCode>12</SystemObjectCode> 
    <SystemObject>Contact</SystemObject> 
    <Created>2002-01-29T16:00:38.787+01:00</Created> 
    <Modified>2002-01-29T17:12:46+01:00</Modified> 
  </Object> 
 

The above return can help identifying the following: 
a. The Object ID to be as a parameter used in a GetObjectValues method call. For instance, 

using the value e7ba11ff-2826-4e89-8192-ba4e94f05e2a as a parameter in GetObjectValues will 

return a (somewhat basic) overview of Contacts on the Entity. 

b. Objects that support having values imported through GL21. Objects returned in GetObjects 

will be eligible for use in column A (Object) in GL21. 


